Word template content and guidelines

Uppsala University thesis template for Word

For information on the template and thesis publishing, please visit www.ub.uu.se/thesis

The Thesis Production division provides a document template for Word in order to make it easier to follow the general guidelines for dissertations published at Uppsala University. This document describes the contents of the template and guidelines to follow when using the template.

Table of contents

The contents of the template................................................................. 1
  Typography ....................................................................................... 1
  Structure of a new document............................................................ 1
  Available styles ................................................................................ 1
  The toolbar menu – UU Menu ......................................................... 2

Guidelines .......................................................................................... 3
  Headings ............................................................................................ 3
  Text .................................................................................................... 3
  Quotations ......................................................................................... 3
  Footnote text and footnote references.............................................. 4
  Footnote text and footnote references for tables............................ 4
  Lists ................................................................................................... 4
  Bibliographic references ................................................................... 4
  Table of contents .............................................................................. 4
  Figures .............................................................................................. 4
  Tables ................................................................................................. 5
The contents of the template

Typography

The template is based on the typography that applies to most theses published at Uppsala University. The page format is S5 (165 x 242 mm), and the font used throughout is Times New Roman with a body text type size of 11 points. The left and right margins are 22.5 mm, the top margin is 18 mm and the bottom margin is 22 mm.

Structure of a new document

A new document created from the thesis template will contain the following pages:

- Title page dummy
- Abstract page dummy
- Dedication page
- List of Papers
- Contents
- Abbreviations
- Introduction

The Title and Abstract pages are replaced by Thesis Production as part of preparing your thesis for printing. The Dedication and Abbreviations pages are optional and the List of papers page is not applicable to monograph theses.

The pages before the first chapter do not have visible page numbers, but every page is counted. In practice this means that the first page with a visible page number will be the page Introduction. Please note that the following pages should be odd numbered pages in your thesis: List of Papers, Contents, and Introduction.

Available styles

Here follows a short summary of the available styles:

**Rubrik (Heading)**
- **Rubrik 1** – Chapter heading, which is always preceded by a page break.
- **Rubrik 2...5** – Headings in hierarchical order.
- **Rubrik vid lista** – Optionally used in connexion with lists.
- **Onnumrerad rubrik** – Does not appear in table of contents.

**Text**
- **Standard** – First paragraph below a heading.
- **Standard med indrag** – Basic style for text.
- **Standard med luft** – Spacing above.
• Tabelltext – Table captions.
• Bildtext – Figure captions.
• Citat – Quoted paragraphs (> 3 lines).
• Citat med indrag – Citat with an indentation of the first line.
• Fotnotstext – Footnote text (applied automatically by Word).
• Fotnotsreferens – Footnote number (applied automatically by Word).
• Fotnotstext vid tabell – Table note text below a table.
• Fotnotsreferens i tabell – Table note symbols within a table.

Tecken (Character)
• Works just like the normal character formatting for Word. Superscript and Subscript are included for easy access.

Lista (List)
• Enkel lista – List without bullets or numbers.
• Enkel lista med indrag – List with an indent.
• Numrerad lista – Numbered list.
• Numrerad lista med indrag – Numbered list with an indent.
• Romersk lista – Roman list.
• Romersk lista med indrag – Roman list with an indent.
• Punktlista – Bullet list.
• Punktlista med indrag – Bullet list with an indent.
• Litteraturlista utan siffror – Reference list.
• Litteraturlista med siffror – Add numbers to a reference list.

Bilder och tabeller (Figures and tables)
• Bildformat – For figures and objects inserted as images.
• Infoga bildbeskrivning – Creates a figure caption.
• Infoga tabellrubrik – Creates a table caption.
• Skapa trelinjerstabell – Creates a table.
• Cellformat – Text within a table.

The toolbar menu – UU Menu

To make the available styles easy to apply and avoid clutter from other commands in Word, the thesis template contains a toolbar that can be used to apply all the necessary formatting. The toolbar can be found in the upper left corner of your screen, or as a tab called UU.

There are styles for headings, body text (Standard), tables, lists, illustrations etc., and if you successfully apply a style from the toolbar the text will have the correct font, size, and amount of space above and below the text. If you can use a style from the toolbar you should avoid changing the settings.

Applying the correct style to headings will also enable Word to update your table of contents correctly.
Guidelines

Headings

The styles Rubrik 1–5 are available for headings and should be used hierarchically. You should use Rubrik 1 for chapter headings; the heading will automatically be placed on top of a new page. Depending on your needs it might not be necessary to use all heading levels in your text, often three or four levels is adequate. Note that you should not leave an empty line after a heading.

The style Rubrik vid lista can be used as a heading to a list. Onnumrerad rubrik is visually the same as a chapter heading, but will not be included in the table of contents.

Text

There are three styles for body text: Standard, Standard med indrag, and Standard med luft. The size is 11 points, with an exact line height set to 13 points, and the margins are justified with straight margins on both the left and right side of the text.

Standard is only used for the first paragraph below a heading. When pressing the Enter key to create a new line after a heading, this style is automatically applied to the empty line. Note that you should not leave an empty line after a heading.

Standard med indrag is the normal body text style and should be used for most of your text. To mark the beginning of a new paragraph, the first line of the paragraph has an indentation of 13 points. When pressing the Enter key to create a new line after either Standard or Standard med luft, this style is automatically applied to the empty line. Note that you should avoid leaving empty lines between paragraphs.

Standard med luft should be used after lists, quotes, graphs, illustrations, equations, and tables. There is a space of 13 points above the paragraph.

Quotations

Quotes longer than three lines are usually inserted as separate paragraphs instead of using quotation marks. To visually separate the quotation from the body text you should apply the style Citat. The text is fully indented by 1 cm from the left margin; text size is set to 10 points with an exact line space of 12 points, and there a space of 13 points above the quoted paragraph.

If the quote is longer than one paragraph you should apply Citat med indrag to all subsequent paragraphs. The first line has an additional indentation of 12 points and there is no space above the paragraph.

Apply Standard med luft to the first paragraph after quoted paragraphs to complete the separation of the quotation from the body text.
Footnote text and footnote references

The styles Fotnotstext and Fotnotsreferens are a built-in styles in Word and are normally applied automatically when inserting footnotes. Footnotes and footnote reference numbers can lose their formatting when cutting and pasting text, and you should reapply the styles if this happens. Fotnotstext and Fotnotsreferens are set to use a text size of 9 points with 10 points line spacing. Fotnotsreferens should be superscript.

Footnote text and footnote references for tables

If you need to insert footnotes to a table, you can use the styles Fotnotstext vid tabell and Fotnotsreferens i tabell for the text below the table and the reference symbol within the table respectively. Word does not apply these automatically.

Lists

There are eight styles for different lists: Enkel lista (without bullets or numbers), Numrerad lista, Romersk lista, and Punktlista; all of them with or without a first line indent.

Apply Standard med luft to the first paragraph after list paragraphs if you wish to separate the list from the body text. An empty line can be inserted if you desire space before the list.

Bibliographic references

Apply one of the styles Litteraturlista utan siffror or Litteraturlista med siffror. The font size is set to 10 points with 12 points of line spacing, and all lines except the first line of each reference are indented by 1 cm. Litteraturlista med siffror is a numbered list and should not be used if you already have numbered references from a reference manager.

If you use EndNote, Refmanager, or any other reference manager you should apply the style of your choice to the reference list after updating it from the software.

Table of contents

Word has a feature that automatically creates a table of contents from your headings. In a new document created from the template you will find a table of contents on page 7, and you can update it by right-clicking, and clicking Update Field. Please note that in order for this to work you have to use the headings as instructed by the thesis template.

Figures

A new figure should be placed in line with text in an empty paragraph and the style Bildformat, should be applied. Bildformat is set to single line spac-
ing with 13 points of space above. Bildformat – or single line spacing – must be used in order to avoid that parts of the figure may overlap with text.

Figure captions are placed under figures. The macro instruction Infoga bildbeskrivning will apply the style Bildtext, insert a numbered caption with the label “Figure”, and apply italics to the label but not the following text. Bildtext should be applied to figure captions and is set to 10 points text size, 12 points line spacing, and a straight left margin.

Tables

Tables should be inserted in line with text in an empty paragraph. The standard table design only has lines before and after the column heading and below the final row of the table and can be applied using the table style Trelinjerstabell. A text size of 10 points with 11 points line spacing is recommended and can be applied with Cellformat.

Table captions are placed above tables. The macro instruction Infoga tabllrubrik will insert a numbered caption with the label “Table” above the selected table and apply the style Tabelltext. Bold lettering will be applied to the label but not the following text. Tabelltext should be applied to table captions and is set to 10 points text size, 12 points line spacing, and a straight left margin.

The macro instruction Skapa trelinjerstabell will create a table of a custom size according to the table design outlined above, but you are free to design your tables using your own formatting.

Updating the Table of Contents (ToC)

You update the ToC by right-clicking on the ToC and selecting Update Field. If you’ve used the summary template correctly all headings should now appear in the Table of Contents. You can decide the number of heading levels to be shown via the option Insert › Reference › Index and Tables… and configure your ToC on the Table of Contents tab.
Tips’n’Trix

Dashes are not the same as hyphens

The hyphen is the shorter than a dash, and is used for hyphenation, some compound words, and in connexion with numbers and abbreviations (for example: “Swedish-English glossary”, “25-year span”, “UN-ambassador”). Dashes are used in the sense “to” and “from”, as between place-names, and in intervals of numbers and time (for example: “Stockholm–Gothenburg”, “30–40 students”, “3–5 p.m.”). In this instance a space is not inserted before and after the dash. You can also use a dash when inserting subordinate clauses; in which case you should insert a space before and after the dash.

You insert a dash through Insert → Symbol... → Special Characters, or via the key combination Ctrl (Macintosh: Alt Key) + “minus”

Deleting “front matter” from the Table of Contents

“Front matter” is the term given to all pages before the Table of Contents – for example a dedication page, a List of Papers, etc. If the headings for these pages are formatted with the style Rubrik 1, they will show in the Table of Contents. To delete them from the ToC, you should format them with the format Onumrerad rubrik (Unnumbered heading). The formatting for the headings in question will stay the same, but they will disappear from the ToC when you update it. (See Updating the Table of Contents.)

Automatic numbering of headings

Choose Format → Bullets and numbering... → Outline Numbered and choose the desired numbering format.
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Cause</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Every time I open the document the heading numbering disappears.</td>
<td>The style is set not to show numbering.</td>
<td>Choose <strong>Tools</strong>  &gt;  <strong>Templates and Add-Ins...</strong> and deselect <strong>Automatically update document styles.</strong></td>
</tr>
<tr>
<td>I can only see a small part of the illustration I inserted, the rest</td>
<td>The line spacing for the Standard format is set to 13 points. In</td>
<td>Choose the style <strong>Bildformat</strong> for the line where you place the illustration.</td>
</tr>
<tr>
<td>of it is hidden.</td>
<td>other words only 13 points (4,5 mm) of the illustration is shown.</td>
<td></td>
</tr>
<tr>
<td>Why are my illustrations displayed as empty squares?</td>
<td>The option <strong>Picture placeholder</strong> is selected to simplify the</td>
<td>Choose <strong>Tools</strong>  &gt;  <strong>Options...</strong>  &gt;  <strong>View</strong> and de-select <strong>Picture placeholder.</strong></td>
</tr>
<tr>
<td>Why can’t I edit the illustration?</td>
<td>handling of the document. Illustrations can’t be edited if you use</td>
<td>Choose <strong>Tools</strong>  &gt;  <strong>Options...</strong>  &gt;  <strong>View</strong> and de-select <strong>Picture placeholder.</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Picture placeholder</strong> instead of displaying the picture.</td>
<td></td>
</tr>
</tbody>
</table>